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3.1 Messen und Darstellen von Ubertragungsfunktionen

In dieser und in den folgenden Ubungen sind Strom-Spannungs-Beziehungen zu messen. Dieser
Abschnitt beschreibt zwei Losungswege fiir diesen Typ von Aufgaben.

ANALOG Source: Data  Image
Supplies <
Vrefl , vmtr 1 (V) Vmtr 2 (V)
Options
Vmtr2 [ ] Comments 1 -0,0497017 -0,0414211
ka [] Headers 2 0924742 0,946314
|:| Labels
U, Vmtrl 3 172825 1,92476
DYy )Ua 4 1,77001 2,87611
L 5 1,84129 3,91631
D: griine LED a) 6 186164 49125 D)

Abbildung 1: a) Messschaltung b) Beispielmesswerte im Export-Fenster von » WaveForms«

Als Beispiel soll die Strom-Spannungs-Kennlinie einer griinen Leuchtdiode mit der Mess-
schaltung in Abb. 1 a bestimmt werden. Die Spannung iiber der Leuchtdiode ist die Ausgangsspan-
nung und der Strom der Spannungsabfall iber dem Widerstand geteilt durch den Widerstandswert:

Ue — U
Ip = 1
P = 0 (1)

Abb. 1b zeigt Beispielmesswerte im Export-Fenster von » WaveForms« und Abb.2a ein Octave-
Programm, das die Daten importiert, die Kennlinie nach Gl.1 berechnet und darstellt.

M = csvread|( , L, 0);

7
Ue=M(:,2): Ua=M(:,1): 6
for idx=1:1length (Ue) 5
T Td (idx) = (Ue(idx)-Ua (idx))/ ; <§
end o 4
plot (Ua, Id, , Ua,Id, ) : '”Q 3
$plot (Ua,Id, 'ro', Ua,Id, 'r', ~ 5
'LineWidth', 3):
%set (gca, 'FontsSize',24); 1
xlabel )i %5 0 o5 1 15 2
ylabel ( ) ; a) uD in V b)

Abbildung 2: a) Octave-Programm b) Darstellung der Strom-Spannungs-Kennlinie
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Als Fufinote! noch einige praktische Hinweise.

(Signalquelle 1) 1 ’ C1 (Messkanal 1)
1RkQ M1 =C2-Cl1 (Mathe-Kanal 1)
Ue C2 (Messkanal 2)
Wavegen v WU | SCOPE
L 3+ L

Abbildung 3: Messschaltung mit Signalgenerator (Wavegen) und Oszilloskop (Scope)

3.2 Kennlinienerzeugung mit Signalgenerator und Oszilloskop

Die Alternative zur manuellen punktweisen Messung ist die Nutzung des Signalgenerators » Wave-
gen« und des Oszilloskops »Scope« vom »Electronics Explorer«. In der Testschaltung Abb. 3
wird das Eingabesignal von Kanal » C1«, die Spannung iiber der Diode von Kanal » C2« und der
Spannungsabfall {iber dem Widerstand vom berechneten Kanal? als Zeitfunktion aufgezeichnet.
Der Signalgenerator, der den Signalverlauf fiir »Cl« bereitstellt, ist so programmiert, dass er
innerhalb von einer Sekunde die Eingangsspannung linear von —8 V auf 8 V erh6ht. Das Oszillo-
skop zeichnen in diesem Zeitintervall 2'3 = 8192 Wertepaare auf. Abb. 4 zeigt die augezeichneten
Signalverldufe.

Done | c1[ca|c3|ca|m1|s192 samplesat s kiz | 2017-10- B, &
1 T

7.5 AR A R e A N N N

Abbildung 4: Scope-Aufzeichung der Kanéle C1, C2 und M1

'Empfehlungen zur manuellen Kennlinienaufnahme und Ergebnisauswertung mit Octave:

e Es ist zu empfehlen, mindestens 10 Messwerte aufzunehmen. Anderenfalls werden Null-Zeilen im Export
eingefiigt.

e Eiir weitere Messwerte, z.B. im Bereich der Krimmung bei Up ~ 1,5V: Werte aufnehmen, in eine andere
Datei exportieren und mit Texteditor in den vorherigen Export an die entsprechenden Stellen einfiigen.

e Bei Vrefl konnen auch direkt Spannungswerte eingegeben werden, die nicht in der Auswahlliste stehen.
Dezimaltrennzeichen ist der Punkt.

e Durch Ersatz der Plot-Anweisung durch die beiden Folgeanweisungen wird die Linienstirke und die Schrift
vergrofiert:

plot(Ua, Id, ’r’, ’LineWidth’, 3);
set(gca, ’FontSize’, 24);

2In der Waveforms« als Mathematik-Kanal bezeichnet.
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In der Scope-Ausgabe sind aufser gemessenen und berechneten Zeitverldufen auch vergroferete
Ausschnitte (Zoom-Fenster) und die funktionale Abhéngigkeit der Werte eines Kanals von den
Werten eines anderen Kanals (XY-Plot) dargestellbar. Abb. 4 rechts zeigt die Differenzspannungen
»M1 = C1 - C2« als Funktion der Spannungswerte von Kanal » C2«. Das ist die mit R multiplizierte

gesuchte Dioden-Kennlinie:
In-R=U,—U, = f(Up)

7.7
4.7

1.7
-1.3

-4.3

-7.3

506 ms Se2ms 213 ms o74ms

Abbildung 5: links Zoom-Fenster, rechts XY-Darstellung (mit R multiplizierte Dioden-Kennlinie)
Der Signalgenerator ist im Wavegen-Fenster (Abb. 6) zu konfigurieren, zu 6ffnen aus dem Start-
fenster iiber die Schaltfliche » Wavegen«. Schrittfolge zur Programmierung;:
e Im Auswahlfeld » Channels« ist nur der erste auszuwéhlen (Haken vor »1«).
e Ein Auswahlfeld weiter rechts » Independent«.
e Uber das Zahnradsymbol hinter » Type« ist » New« auszuwihlen.

Im sich 6ffnenden Fenster Reiter » Math« auswéhlen. Einstellungen fiir einen linearen Verlauf
wie in Abb. 7 einstellen:

— Samples 4196 (Anzahl der Aufzeichnungswerte),
— X from 0 to 1 (Wertebereich X) ,
— 2*X+1 (Berechnungsvorschrift fiir die Funktionswerte).

Ubernahme des Signalverlaufs mit »Generate« und » OK«.

Welcome | Help B wavegen 1[5 | scope 1]

File Control Edit Window =
.' Run Al Channels = | | Independent i

Channel 1 g X
P> run Enable |smple v | &3] Mone v Wwait: [none ~|[1s ME + [ Repeat Trigger
Type: /Customl - ||k

Frequency: 1Hz ~

Amplitude: 3y e

Offset: av ™

Symmetry: 50 %

Phase: oe ~| 0s 0.2s 0.4s 0.6s 0.8s 1is

Abbildung 6: Weitere Wavegen-Einstellungen
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Mame: |Custom1 |
Func Math Values File Alter

-

Samples: (Bo26 3| device: 4025 3
X from: to;

Script &% Options

2%¥-1

Insert

4

[] Mormalize Generate 0% 50 2% 100 %

Abbildung 7: Wavegen-Programmierung

o Weitere Einstellungen des Signalgenerators im Fenster Abb. 6:

— Leiste oben: »Simple«, kein Trigger, Run 1s, Repeat 1, ...
— linke Leiste: Frequency 1 Hz, Amplituse 8V, ...

Das Oszilloskop ist im Scope-Fenster (Abb. 8) zu konfigurieren:
e Obere Leiste: Source: Wavegen 1 (Aufzeichnungsstart durch den Signalgenerator).

e Oberhalb der Channels Haken bei Time. Position: 500ms. Base 100ms/div (Einstellung fiir
Aufzeichnung ab Abspielbeginn fiir 15s).

e Channel 1 und 2 aktivieren: Offset: 0V, Range: 1,5 V/div (Diese Kanile ohne Verschiebung
in X-Richtung mit 1,5 je Késtchen anzeigen).

o Differenzanzeige: Rechtsklick im grauen Bereich unter » Channel 4«. Unter »Math« »Simple«
wihlen. Offset: 0V. Range: 1,5 V/div. C1 - C2 (Differenz).

B single P scan Mode: Soeen T | Auto ~ |Source:  |Wavege v |Condition: | | Risi = Level: 5V

y Done |1 [c2|ca|ca|mi a9z samples at 7. 042k0z j 20 B, 5 B B[] v -
T T | T | T I T ¥

T T T T

77 | I I l | Channel 2 L
T T T T T T T T e Offset: ov v
7 R 1.5 V/di

ange: ) -
T T T O A ST SRS SN SOt (PPt SN | | Jdiv
1.7 I Channel 3 pY I
0.2

P S N A A A S : [ ] Channel 4 LY
28 | : ----------- L Math 1 ][
43 [ : S U SO OO URURORt MUY SUSROR H Offset: -200 my ~
5.8 | : : : : : e H Range: 1.5 V/div ~

-7.3
. - -
Xl" 0,113 0.114s 0.338s 0.562s 0.786s 101s £l c

Abbildung 8: Scope-Fenster

Durchfiihrung der Messung:

e Button »Single« betétigen (fiir das Oszilloskop eine einmalige Aufzeichnung starten).
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e Warten bis der Trigger-Zustand von » Done« iiber » Configured« weiter auf » Armed« (scharf)
wechselt.

o Im Wavegen-Fenster Button » RUN Wavegen« driicken®.

e Abwarten, bis der Trigger-Zustand im Scope-Fenster weiter iiber » Trig’d« (Datenaufzeich-
nung) nach »Done« (fertig) wechselt.

Ergebnis sind die bereits gezeigten Signalverldufe in Abb. 8 .

Erzeugung des Zoom-Fenster wie in Abb. 5a:
e View > Add Zoom.

e Zur zu untersuchenden Stelle verschieben und Grofie anpassen:

— Rechtsklick im Zoom-Fenster,
— Beispieleinstellungen: H-Offset 50%, H-Range 20%, V-Offset 30% und V-Range 20%.

Erzeugung der XY-Darstellung der mit R multiplizierten gesuchten Kennliniein in Abb. 5b:
e View > Add XY.
e Im XY-Fenster, fiir X »C2« und fiir Y » M1« auswéhlen.
Datenexport nach Octave:
e Im Oszilloskop-Fenster File > Export, Source XY1,
e Haken nur bei »Headers«, Save, Ort und Dateinamen auswéhlen, ...
Datenimport in Octave:
e Ordner mit der exportierten Datei auswéhlen.

e Import und Anzeige mit nachfolgender Befehlsfolge:

% Einle in eine 2ZD-Matrix

clear:; 15schen

h = csvread | 1, 0);

% 1 —— erste Zeile (Tabellenkopf/Headers) weglassen
% 0 — ab erste Spalte

plot(a(:,1), a(:,2), , 3):

% Ausdruck von Spalte 2 als Funktion von Spalte 1
set (gca, 24) ;

xlabel | )

ylabel ( ) :

Das Ergebnis ist dasselbe wie in Abb. 1b, nur mit mehr Messpunkten. Darstellung eines Teilbe-
reichs [<anf>, <ende>] der Kennlinie in Octave:

anf = 300;
ende = 700;
plot(a(<anf>:<ende>,1), a(<anf>:<ende>,2, ...)

30der im Scope-Fenster bleiben und das griine Dreieck vor dem Reiters des Fensters Wavegen anklicken.
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3.3 Aufgaben
Aufgabe 3.1: Vorwiderstand berechnen (Hausaufgabe)

Wie grof muss der Widerstand R in der nachfolgenden Schaltung mindestens sein, wenn der
Wertebereich fiir die Eingangsspannung —5V < U, < +5V, die Flussspannung der Diode Ur =
0,7V, die Durchbruchspannung in Sperrrichtung Us < —10V und der Strom durch die Diode in
Durchlassrichtung auf Ip < 10 mA beschrankt sein soll?

Ueﬁ:'*} ) oo

Aufgabe 3.2: Ersatzschaltungsparameter berechnen (Hausaufgabe)
Zeichnen Sie in Abb. 2b eine sinnvolle Kennlinienanniherung durch zwei Liniensegmente mit den
Funktionen

I — 0 Up < Up

b= UDR—DUF Up > Up

ein und schitzen Sie unter Nutzung der Daten aus Abb. 1b die Grofe der Modellparameter Up
(Flussspannung) und Rp (Widerstand im Durchlassbereich). Uberlegen Sie sich ein geschicktes
Vorgehen, wie Sie fiir eine Diode mit unbekannten Parametern die Eingangsspannungen fiir zwei
Messungen so auswéhlen, dass Sie gute Schitzwerte fiir beide Parameter erhalten. Stellen Sie die
Formeln fiir die Berechnung der Parameter aus den Ergebnissen beider Messungen auf.

Aufgabe 3.3: Diodenkennline messen

Bauteile: Widerstand 1k{2, griine Leuchtdiode

A

Bestimmen Sie fiir die Schaltung in Abschnitt 3.1 auf einem der beiden beschriebenen Wege die
Strom-Spannungs-Kennlinie der griinen Leuchtdiode etwa im selben Bereich wie in Abb. 1b. (Vom
Schaltungsaufbau bis zum Octave-Import und der Kennlinienvisualisierung.)

Aufgabe 3.4: Kennlinie Z-Diode messen

Bauteile: Widerstand 1k{2, Z-Diode ZF 5,6

—C—
Anode Kathode

Bestimmen Sie in derselben Weise wie in der Aufgabe zuvor die Strom-Spannungs-Kennlinie fiir
die Z-Diode ZF 5,6.
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Aufgabe 3.5: Ersatzschaltungsparameter unterschiedlicher Dioden
Bauteile: Widerstand 1k, Diode 1N4148, Diode BAT 43, Leuchtdiode rot

Anode T Ktth':K Ao
nodae athode A

Bestimmen Sie iiber die Vorgehensweise, die Sie sich in Aufgabe 2 tiberlegt haben, fiir
a) einer Siliziumdiode 1N4148
b) eine Schottky-Diode BAT 43 und
c) eine rote Leuchtdiode

die beiden Modellparameter Ug (Flussspannung) und Rp (Widerstand im Durchlassbereich). Do-
kumentieren Sie die Ergebnisse und Zwischenergebnisse in der nachfolgenden Tabelle:

Uel Ual IDl Ue2 Ua2 ID2 UF RD

1N4148
BAT 43
rote LED

(Index 1/2 bezeichnet die Nummer der durchgefiithrten Messung)

Aufgabe 3.6: Einfacher Gleichrichter
Bauteile: Widerstand 1kS2, Leuchtdiode rot

A

Bestimmen Sie fiir den einfachen Gleichrichter mit einer roten Leuchtdiode als Diode und dem
nachfolgenden Messaufbau

Vrefl, Vimtrl g . Vmtr2 zu nutzende Anschliisse
AWG1, DC1 DC2 des Electronics Explorers
Ue( r ) Ua fiir Einzelmessung
L mit Wavegen und Scope

die Ubertragungsfunktion U, = f (U.) und stellen Sie das Ergebnis mit Octave graphisch dar.
Kontrollieren Sie abschliefend, in welchem Bereich der Eingangsspannung U, die Diode leuchtet
und in welchem sie nicht leuchtet.
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Aufgabe 3.7: Briickengleichrichter
Bauteile: Widerstand 1k€2, 4 Leuchtdioden rot

A

A

Bestimmen Sie die Ubergangsfunktion U, = f (U,) fiir den Briickengleichrichter mit dem nachfol-
genden Messaufbau:

Vrefl, Vmtrl

AWG1, DC1
Diy Ds . Vmtr2
U DC2
e R=1kQ ) Ua zu nutzende Anschliisse
\ Vmtr3 | es Electronics Explorers
D3R Dy DC3 fiir Einzelmessung

mit Wavegen und Scope

Aufgabe 3.8: Dioden-UND
Bauteile: Widerstand 1k€2, 4 Leuchtdioden rot

A
A

Realisieren Sie den Messaufbau fiir den Test eines UND-Gatters aus Dioden entsprechend der
nachfolgenden Skizze:

VP+ (5V, 10mA)

D Ry =1k
5V | Vrefl, Vmtrl ! D Vmtr3
________ 3 N e .
AWGL, DCL Dy D Hleetonics Explovers
Ue | Vref2, Vmtr2 R p
AWG2, DC2 U L Dy 472kQ ) U, | fiir Einzelmessung
1 ' ey ik mit Wavegen und Scope

a) Messen Sie die Ausgangsspannung U, in Abhingigkeit von den Eingangsspannungen U
und Us, fiir die in der nachfolgenden Tabelle vorgegebenen Eingabewerte. Ergénzen Sie in
der untersten Spalte die Nummern der leuchtenden LEDs.

Uer OV |1V |2V |3V |4V |1V |2V |3V |4V |5V
Ue2 1V |2V |3V [4V |5V |0V |1V |2V |3V |4V
Ua

leuchtende LEDs

b) Welche Funktion hat die Diode D4? Uberpriifen Sie Ihre Vermutung, indem Sie die Diode
weglassen, die Messungen wiederholen und die Ergebnisse mit denen aus dem Aufgabenteil
a vergleichen.
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Abnahmekriterien
Aufgabe 3.1: Sinnvoller Vorwiderstand.

Aufgabe 3.2: Sinnvolle Werte fiir Up und Rp. Regeln fiir die Messpunkteauswahl und die beiden
Formeln fiir die Parameterbestimmung.

Aufgabe 3.3: Octave-Kennlinien-Plot (Import-Datei und m-Script zur Erzeugung des Plots).
Aufgabe 3.4: Octave-Kennlinien-Plot.
Aufgabe 3.5: Ausgefiillte Tabelle.

Aufgabe 3.6: Octave-Plot der Ubertragungsfunktion. Angabe des Eingangsspannungsbereichs,
in dem die Diode leuchtet.

Aufgabe 3.7: Octave-Plot der Ubertragungsfunktion. Angabe der Eingangsspannungsbereiche,
in denen die einzelnen Dioden leuchten.

Aufgabe 3.8: Ausgefiillte Tabelle.

Die Teilnehmer sagen, welche Aufgaben sie gelost haben. Der Hilfswissenschaftler fithrt Stichpro-
benkontrollen zu den als fertig gemeldeten Aufgaben durch.



